Carryover Detection Tutorial
for the
MPX™ Driver Software
This document is provided to customers who have purchased SCIEX equipment to use in the operation of such SCIEX equipment. This document is copyright protected and any reproduction of this document or any part of this document is strictly prohibited, except as SCIEX may authorize in writing.

Software that may be described in this document is furnished under a license agreement. It is against the law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license agreement. Furthermore, the license agreement may prohibit the software from being disassembled, reverse engineered, or decompiled for any purpose. Warranties are as stated therein.

Portions of this document may make reference to other manufacturers and/or their products, which may contain parts whose names are registered as trademarks and/or function as trademarks of their respective owners. Any such use is intended only to designate those manufacturers’ products as supplied by SCIEX for incorporation into its equipment and does not imply any right and/or license to use or permit others to use such manufacturers’ and/or their product names as trademarks.

SCIEX warranties are limited to those express warranties provided at the time of sale of license of its products and are SCIEX’s sole and exclusive representations, warranties, and obligations. SCIEX makes no other warranty of any kind whatsoever, expressed or implied, including without limitation, warranties of merchantability or fitness for a particular purpose, whether arising from a statute or otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed, and assumes no responsibility or contingent liability, including indirect or consequential damages, for any use by the purchaser or for any adverse circumstances arising therefrom.

For research use only. Not for use in diagnostic procedures.

AB Sciex is doing business as SCIEX.

The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their respective owners.

AB SCIEX™ is being used under license.

© 2017 AB Sciex

AB Sciex Pte. Ltd.
Blk 33, #04-06
Marsiling Ind Estate Road 3
Woodlands Central Indus. Estate.
SINGAPORE 739256
Walk-Up Workspace in Version 2.0 of the MPX™ Driver Software

The Walk-Up workspace in the MPX™ driver software contains the following panes, each providing the user with different access points to MPX™ driver software functionality and information related to the system:

- Submitted Batches pane. Refer to Submitted Batches on page 5.
- Samples in Batch pane. Refer to Samples in Batch on page 6.
- Sample Execution History pane. Refer to Sample Execution History on page 7.
- Instrument status pane. Refer to Instrument Status on page 8.
- Notification Messages dialog. Refer to Notification Messages Dialog on page 8.

**Note:** The icon that is used to open the Notification Messages dialog is only accessible if messages or warnings were generated during the sample run.

The Walk-Up workspace in the MPX™ driver software enables the user to submit batches, modify batch order, and delete selected samples or batches through the MPX™ driver software. The user does not have to use the Analyst® software to perform these actions.

Refer to:
- Submit a Batch in the Walk-Up Workspace on page 17.
- Change the Batch Order on page 6.
Submitted Batches

The Submitted Batches pane contains a list of all of the batches that have been submitted. The pane contains one row for each batch submitted, providing the user with information related to the status of the batch, the submission order, the approximate batch start and finish times, the name of the batch, the batch owner, the number of samples contained in the batch, and so on.

Figure 1-2 Submitted Batches Pane
Change the Batch Order

The order of the batches can be changed according to user needs.

**Note:** Only batches that have not been submitted to the Analyst® software queue can be moved up and down or deleted in the MPX™ driver software Walk-Up workspace.

1. In the Submitted Batches pane, select the appropriate batch.
2. Do one of the following:
   - To move the selected batch and all of the subsequent batches to the top of the list, click the icon.
   - To move the selected batch up in the list, one row at a time, click the icon.
   - To move the selected batch down in the list, one row at a time, click the icon.
   - To delete the selected batch from the list, click the icon.
   - To delete the selected batch and all of the subsequent batches from the list, click the icon.

Status

The **Status** column shows a series of icons indicating the batch status:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄️</td>
<td>All of the samples in the batch have completed successfully, but at least one sample has a warning message.</td>
</tr>
<tr>
<td>⚡️</td>
<td>The batch is in progress.</td>
</tr>
<tr>
<td>⚡️️</td>
<td>The batch has been submitted, but is waiting to begin.</td>
</tr>
<tr>
<td>⚩️</td>
<td>The batch has completed successfully, but at least one sample has failed.</td>
</tr>
<tr>
<td>✅️</td>
<td>All of the samples in the batch have completed successfully, with no warning message.</td>
</tr>
<tr>
<td>✖️️</td>
<td>At least one sample in the batch has failed.</td>
</tr>
</tbody>
</table>

Samples in Batch

The Samples in Batch pane contains a list of all of the samples within a batch. The Samples in Batch pane contains one row for each sample in the selected batch, providing the user with information related to the status of the sample, the submission order, the approximate sample start and finish times, the name of the sample, the assigned
and submission stream, the barcode of the sample, the plate position, and so on. Any RTD$^3$ Carryover Detection messages related to the sample are shown in the Message column.

**Figure 1-3 Samples in Batch**

<table>
<thead>
<tr>
<th>Status</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>✓</strong></td>
<td></td>
<td>The sample is in progress.</td>
</tr>
<tr>
<td><strong>● ●</strong></td>
<td></td>
<td>The sample is waiting.</td>
</tr>
<tr>
<td><strong>⚠️</strong></td>
<td></td>
<td>The sample has completed successfully, but contains a warning message.</td>
</tr>
<tr>
<td><strong>✔️</strong></td>
<td></td>
<td>The sample has completed successfully.</td>
</tr>
<tr>
<td><strong>❌</strong></td>
<td></td>
<td>The sample has failed.</td>
</tr>
</tbody>
</table>

**Sample Execution History**

The Sample Execution History pane contains a complete list of all of the injected samples, Blank sample re-injections, and carryover sample re-injections. The Sample Execution History pane contains one row for each submitted sample, providing the user with information related to the status of the sample, the submission order, the approximate sample start and finish times, the name of the sample, the associated stream number, the plate and vial positions, and so on. Any RTD$^3$ Carryover Detection messages related to the sample are shown in the Message column.
Instrument Status

The instrument status panel is shown at the bottom of all of the MPX™ driver software workspaces. The status panel provides a visual status of the mass spectrometer, LC stream 1, and LC stream 2.

Table 1-1 Status Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green Icon" /></td>
<td>Ready</td>
</tr>
<tr>
<td><img src="image" alt="Yellow Icon" /></td>
<td>Standby</td>
</tr>
<tr>
<td><img src="image" alt="Red Icon" /></td>
<td>Fault</td>
</tr>
</tbody>
</table>

Notification Messages Dialog

The Notification Messages dialog contains a list of all important messages and warnings generated during the sample run. The messages identify issues with the MPX™-2 High Throughput System. Users can acknowledge and clear these messages, as required.
1. To access the Notification Messages dialog, click the icon in the bottom-right corner of the Walk-Up workspace.

Figure 1-6 Notifications Messages Dialog

2. To delete the messages, do one of the following:

- To delete an individual message, click the icon that is shown at the right of the message.
- To delete all of the messages, click **Clear All** at the bottom of the Notification Messages dialog.
The Real Time Data Dependent Decision (RTD³) Carryover Detection feature enables the user to set a series of Low and High concentration thresholds for various analytes. When the Carryover Detection option is selected, the RTD³ logic improves sample throughput by minimizing the number of sample re-injections that need to be performed due to sample stream contamination or suspected carryover.

Carryover Detection is designed for high throughput analytical workflows using the same analytical methods on Stream 1 and Stream 2.

After a series of Low and High thresholds have been set in the MPX™ driver software, the RTD³ can flag:

- Unknown sample concentration level that exceeds a specified High limit value or a specified Region Height value.
- Blank sample concentration level that exceeds a specified Low limit value.

When an Unknown sample concentration level is below the specified High limit value, the next sample is injected. When an Unknown sample concentration level exceeds the specified High limit value, a Blank sample is automatically injected. For systems equipped with a CTC autosampler, the Blank sample is injected on the other stream. For systems equipped with a Shimadzu autosampler, the Blank sample is injected on the same stream.

For systems equipped with a CTC autosampler, if the Unknown sample concentration level exceeds the Lower limit value and was preceded by a sample with a concentration level that exceeded the High limit value, then Carryover Detection is enabled and the Unknown sample is flagged with the message Carryover was detected. The Unknown sample is re-injected at the end of the batch.

When a Blank sample concentration level is below the specified Low limit value, the stream is considered clean and the next sample is injected. When a Blank sample concentration level exceeds the Low limit value, the RTD³ functionality will inject up to three Blank samples, in succession. If the calculated sample concentration of the third Blank sample still exceeds the Low limit value, then the sample stream stops injecting to prevent carryover contamination of the other samples in the batch.

Because there are small differences in response between the two streams, Carryover Detection does not provide an absolute quantitation value, but rather a rough concentration guide that is useful for flagging suspect samples. For final analytical quantitation and reporting, we recommend that the entire data file be processed using either the MultiQuant™ software or the Analyst® software to confirm the findings.

Requirements

Carryover Detection can only be performed in the Walk-Up workspace of the MPX™ 2.0 driver software.

The Carryover Detection function requires the following components:
• An MPX™ driver software acquisition method (stream 1 or stream 2 only). The method must include an Analyte ID for each MRM transition. Refer to Create the MS Component of a Method in the MPX™ driver software Help.

• An Analyst® software quantitation method. Refer to Create the LC Component of a Method in the MPX™ driver software Help.

• A sample batch created using the Analyst® software, with a single sample set containing the sample name, location, sample type, and the concentration values for calibration samples. Refer to Create a Batch on page 13.

• A MultiQuant™ software, version 3.0.2 or later, quantitation method. Refer to Create a Carryover Detection Compatible MultiQuant™ Software Quantitation Method on page 15. The same MultiQuant™ software method must be used for both stream 1 and stream 2.

**Note:** Version 3.0.2 of the MultiQuant™ software is only compatible with the 64-bit version of the Microsoft Windows 7 operating system. Version 3.0.3 of the MultiQuant™ software is compatible with the 64-bit version of both the Microsoft Windows 7 and the Windows 10 operating systems.

• The Carryover Detection check box must be selected on the Submit Batch dialog. This check box is only available for selection if all of the above criteria is met.

### Carryover Detection Messages

**Table 2-1 Messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above upper concentration limit was detected</td>
<td>The concentration level of an Unknown sample exceeds the specified High limit value.</td>
</tr>
<tr>
<td>Above region height threshold was detected</td>
<td>The concentration level of an Unknown sample exceeds the specified Region Height value.</td>
</tr>
<tr>
<td>Above lower concentration limit was detected</td>
<td>The concentration level of a Blank sample exceeds the specified Low limit value.</td>
</tr>
<tr>
<td>Carryover was detected</td>
<td>The concentration level of an Unknown sample exceeds the specified Low limit value and was preceded by a sample that exceeded the specified High Limit value.</td>
</tr>
</tbody>
</table>
## Carryover Detection

### Figure 2-1 Example Messages

<table>
<thead>
<tr>
<th>Status</th>
<th>#</th>
<th>Time Started</th>
<th>Time-Completed</th>
<th>Sample Name</th>
<th>Stream Assigned Stream</th>
<th>Plate Position</th>
<th>Vial Position</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>1</td>
<td>2017/11/10 11:23:29</td>
<td>2017/11/10 11:25:30</td>
<td>Rinse</td>
<td>1 1 2 1</td>
<td> </td>
<td> </td>
<td>Above carryover concentration limit was detected</td>
</tr>
<tr>
<td>✔</td>
<td>2</td>
<td>2017/11/10 11:25:38</td>
<td>2017/11/10 11:27:39</td>
<td>Rinse</td>
<td>2 2 1</td>
<td> </td>
<td> </td>
<td>Carryover was detected</td>
</tr>
<tr>
<td>✔</td>
<td>3</td>
<td>2017/11/10 11:30:19</td>
<td>2017/11/10 11:32:39</td>
<td>Cal 16</td>
<td>1 1 2 6</td>
<td> </td>
<td> </td>
<td>Above carryover concentration limit was detected</td>
</tr>
<tr>
<td>✔</td>
<td>5</td>
<td>2017/11/10 11:37:09</td>
<td>2017/11/10 11:39:19</td>
<td>Cal 16</td>
<td>1 1 2 5</td>
<td> </td>
<td> </td>
<td>Carryover was detected</td>
</tr>
<tr>
<td>✔</td>
<td>6</td>
<td>2017/11/10 11:39:29</td>
<td>2017/11/10 11:41:39</td>
<td>Cal 16</td>
<td>2 2 1</td>
<td> </td>
<td> </td>
<td>Above carryover concentration limit was detected</td>
</tr>
<tr>
<td>✔</td>
<td>7</td>
<td>2017/11/10 11:44:04</td>
<td>2017/11/10 11:46:05</td>
<td>Blanks</td>
<td>1 1 2</td>
<td> </td>
<td> </td>
<td> </td>
</tr>
<tr>
<td>✔</td>
<td>9</td>
<td>2017/11/10 11:50:53</td>
<td>2017/11/10 11:52:54</td>
<td>Unknown S1</td>
<td>1 1 2 11</td>
<td> </td>
<td> </td>
<td>Above carryover concentration limit was detected</td>
</tr>
<tr>
<td>✔</td>
<td>10</td>
<td>2017/11/10 11:53:13</td>
<td>2017/11/10 11:55:14</td>
<td>Unknown S2</td>
<td>1 1 2 10</td>
<td> </td>
<td> </td>
<td>Carryover was detected</td>
</tr>
<tr>
<td>✔</td>
<td>12</td>
<td>2017/11/10 12:00:03</td>
<td>2017/11/10 12:02:04</td>
<td>Blanks (rejected 2)</td>
<td>1 1 2</td>
<td> </td>
<td> </td>
<td> </td>
</tr>
<tr>
<td>✔</td>
<td>13</td>
<td>2017/11/10 12:03:56</td>
<td>2017/11/10 12:06:56</td>
<td>Blanks (rejected 3)</td>
<td>1 1 2</td>
<td> </td>
<td> </td>
<td> </td>
</tr>
</tbody>
</table>
Create a Batch

Refer to Requirements on page 10 for a list of criteria that must be met for Carryover Detection to function as expected.

**Note:** For the Carryover Detection feature to be available in the MPX™ driver software, the batch must be set up as follows:

- At least one calibrator sample must be identified as a **Standard**.
  
  **Note:** If multiple Standard samples are used, then the same Sample Name can be used for each Standard sample. However, the Vial Position for each sample must be unique.

- At least one negative control sample must be identified as a **Blank**.
  
  **Note:** If multiple Blank samples are used, then the same Sample Name can be used for each Blank sample. However, the Vial Position for each sample must be unique. The RTD³ (Real Time Data Dependent Decision) feature uses the most recent Blank sample which does not exceed the low concentration limit set by the user. Refer to Define Carryover Detection Limit Values on page 21.

- The **Standard** samples must precede the **Blank** samples in the batch.

- Samples that are to be evaluated by the Carryover Detection feature must be identified as **Unknown**.
  
  **Note:** If multiple Unknown samples are used, then the same Sample Name can be used for each Unknown sample. However, the Vial Position for each sample must be unique.

- Samples identified as **Solvent**, **Double Blank**, or **QC** can be inserted anywhere in the batch. These sample types are ignored by the Carryover Detection feature and are not processed by the RTD³ method.

1. In the Analyst® software, make sure that the correct project folder is selected.
2. Click **File > New**.
   
   The New dialog opens.
3. Click **Acquisition Batch** and then click **OK**.
   
   The Batch Editor window opens.
4. On the **Sample** tab, in the **Set** field, type a name for the set and then click **Add Set**.
5. Click **Add Samples**.
Create a Batch

The Add Samples dialog opens.

6. Type the number of samples for the set in the **Number** field and then click **OK**.

The Add Samples dialog closes.

7. In the **Acquisition** field, select the acquisition method for the set.

8. In the **Quantitation** field, select the quantitation method for the set.

9. In the samples table, type the **Sample Name**, **Vial Position**, and **Data File** for each sample in the batch.

**Note:** The information provided in **Figure 3-1** is for information purposes only.

**Figure 3-1 Create Batch—Sample Tab**

10. Click the **Quantitation** tab.

11. Type the appropriate Quant Type information for each sample in the batch.

**Note:** If multiple Standard, Blank, or Unknown samples are used, then the same Sample Name can be used for each sample but the Vial Position for each sample should be unique.
12. Click **File > Save**.

The **Save Acquisition Batch** dialog opens.
13. Type a **File name** for the batch and then click **Save**.

### Create a Carryover Detection Compatible MultiQuant™ Software Quantitation Method

The quality of the quantitation method used determines how effectively carryover can be detected. Because the Carryover Detection functionality generates a concentration value for each Unknown and Blank sample, it is important that the concentration be as accurate and reliable as possible so that the appropriate flags can be generated by RTD.<sup>3</sup>

1. If the MultiQuant™ software is not open, then double-click **MultiQuant** under **Companion Software** on the Navigation bar of the Analyst® software.

**Tip!** When using the RTD<sup>3</sup> Carryover Detection feature, use the **SignalFinder™** algorithm. This algorithm provides a wider linear dynamic range and more accurate quantitation results. In the MultiQuant™ software, click Edit > Project Integration Defaults and then select **SignalFinder1** from the Integration Algorithm list.

2. In the MultiQuant™ software, click **File > New Quantitation Method**.
3. Select the appropriate **Sample** file from the list provided and then click **OK**.

If the required **Sample** file is not shown, then browse to the appropriate folder and select the file.
4. On the **Components** tab, select the check box beside the internal standard, if applicable.
5. Select the **Group ID** and the **IS** name from the list provided.
6. Verify the **Q1/Q3 Transition** from the list provided and modify, if required.

**Figure 3-3 Components Tab**

7. On the **Integration & Regression** tab, type the appropriate values for the integration parameters.

**Tip!** For single point calibrators, type Linear Through Zero in the Fit field. If applicable, for internal standards, type an area value that is approximately 20% to 30% of the average value for the internal standard in the Min. Peak Height field.

8. On the **Outlier Settings** tab, type the appropriate values for the calculated concentration limits.

**Note:** For the RTD³ functionality, the Lower Limit of Calculated Concentration (LLCC) and the Upper Limit of Calculated Concentration (ULCC) fields are the most important. These values set the concentration limits used by the RTD³ Carryover Detection feature to assess the Above Lower Concentration Limit and the Above Upper Concentration Limit flagging comments. The LLCC and ULCC values are used when a selected MultiQuant™ software method is used for carryover detection. The default values in the Carryover Detection pane of the Walk-Up workspace can be modified during batch submission, if required.
Submit a Batch in the Walk-Up Workspace

1. In the MPX™ driver software, in the Workspace pane, click **Walk-Up**.
   
The Walk-Up workspace opens.
2. In the Walk-Up section, click **Submit Batch**.

   The Submit Batch dialog opens.
3. Make sure that the correct Project is shown and then select the appropriate batch from the list provided.

Note: If the batch does not meet the Carryover Detection criteria, then the batch can still be submitted but the Carryover Detection feature will not be invoked. Refer to Requirements on page 10.
Create a Batch

**Note:** If the batch meets the criteria for the Carryover Detection feature, then the Carryover Detection check box is automatically selected and a list of available MultiQuant™ software qmethods is shown.

4. Select the appropriate qmethod from the list provided.

A list of defined limit values that are associated with the selected method is shown. Refer to Define Carryover Detection Limit Values on page 21.

**Figure 3-8 Submit Batch Dialog—Carryover Detection Batch**

![Submit Batch Dialog—Carryover Detection Batch](image)

**Note:** All of the transitions contained in the MultiQuant™ software method are listed. The Low, High, and Region Height values can be modified, if required. Refer to Define Carryover Detection Limit Values on page 21. If the method is being used for the first time, then the original values are shown. If the method has been used in a previous submission, then the values that were used for the previous submission are shown.

5. After all of the required changes have been made, click **Submit**.

The batch is shown in the Submitted Batches pane of the Walk-Up workspace. Any RTD³ Carryover Detection messages related to the sample are shown in the Messages column.
Figure 3-9 Samples in Batch

Note: The data (wiff) file that is generated will contain all of the samples in the submitted batch, including any re-injected Blank samples and any re-injected carryover flagged samples.

Define Carryover Detection Limit Values

Notes:

- The Carryover Detection limit values must be defined during batch submission in the Walk-Up workspace.
- Although the MultiQuant™ software allows a maximum of 26 digits in each of the Lower Limit Calculated Concentration and Upper Limit Calculated Concentration fields, a maximum of 7 digits is allowed in the Carryover Detection Limit values table.
- Commas (,) are not supported as decimal separators. If a comma is used, then the MPX™ driver software ignores the comma and interprets the value as an integer. For example, if 5,01 is typed, then the software interprets this value as 501.

1. Make sure that the **Use** check box is selected for each analyte to be evaluated by the Real Time Data Dependent Decision (RTD³) feature.

Note: By default, the Use check box is selected for all analytes. Users can clear the check box, if required. However, if the Use check box is not selected, then the corresponding analyte will not be evaluated by the RTD³ carryover detection function. The Use check box cannot be selected for analytes that have been identified as internal standards in the quantitation method (qmethod) file.
2. Set the detection limit values using the guidelines provided. Refer to Table 3-1.

Table 3-1 Detection Limit Value Guidelines

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the analyte, as defined in the quantitation method (qmethod) file. This field is automatically populated and cannot be modified.</td>
</tr>
</tbody>
</table>
| Low   | The lower limit of the calculated concentration used by the RTD³ Carryover Detection function for the evaluation of Blank samples.  
  - The Low value is mandatory.  
  - The Low value can be modified.  
  - The Low value cannot be less than or equal to zero.  
  - The Low value can contain a maximum of five decimal places and seven digits.  
  - The Low value must be between 0.00001 and 9999999.  
  - The Low value must be less than the High value. |
### Table 3-1 Detection Limit Value Guidelines (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>The upper limit of the calculated concentration used by the RTD&lt;sup&gt;3&lt;/sup&gt; Carryover Detection function for the evaluation of <strong>Unknown</strong> samples.</td>
</tr>
<tr>
<td></td>
<td>• The High value can be modified.</td>
</tr>
<tr>
<td></td>
<td>• The High value cannot be less than or equal to zero.</td>
</tr>
<tr>
<td></td>
<td>• The High value can contain a maximum of five decimal places and seven digits.</td>
</tr>
<tr>
<td></td>
<td>• The High value must be between 0.00001 and 9999999.</td>
</tr>
<tr>
<td></td>
<td>• The High value must be greater than the Low value.</td>
</tr>
<tr>
<td></td>
<td>• If the corresponding Region Height value is provided, then the High value can be left blank.</td>
</tr>
<tr>
<td>Region Height</td>
<td>An upper limit defined in counts per second (cps) either alone or in conjunction with the High value.</td>
</tr>
<tr>
<td></td>
<td>• The Region Height window is equivalent to 1.5 times the normal Retention Time window used for the quantitation method (qmethod) analyte integration.</td>
</tr>
<tr>
<td></td>
<td>• The format is scientific notation only, with a maximum of two decimal places and a maximum exponent value of seven.</td>
</tr>
<tr>
<td></td>
<td>• Acceptable formats include values such as: 1e7, 1.0e7, and 9.99e6.</td>
</tr>
</tbody>
</table>